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USERS GROUP MEETING

We are excited to be hosting the 2022 Users Group Meeting in person! We hope to see you in
Las Vegas for a time to connect, learn, and have fun. You can view the speakers, class list, learn
more about the Game Night Party, and everything you need to know about the Users Group

Meeting at ugm.ortho2.com.

REGISTER TODAY!

Join us for the 38th annual Users Group Meeting in Las
Vegas! The meeting will take place January 27-29, 2022 at
Planet Hollywood.

Register online at www.ortho2.com/ugmregistration. If you
have questions, contact Kim Barker, Meeting and Event
Coordinator at 800.678.4644 or ugm@ortho2.com.

Each of the more than 40 classes are designed for every
member of your team — from the doctor, to the treatment
coordinator, even the marketing coordinator and clinical
team member. The diverse group of presenters includes
Ortho2 team members, industry-leading doctors, and
consultants.

GAME NIGHT PARTY

Advancing your practice is the main reason to come, but
you won't want to miss the epic opening party. Join us for
the Game Night Party, where you'll be Sorry if you don't
show up!

SOCIAL MEDIA

While you are at the UGM, don’t forget to share your
pictures and videos with us through our social media
channels. Find us on Instagram, Facebook, and Snapchat.




IF WORKFLOWS THINK, DO THEY

MAKE YOU MORE EFFICIENT?

MIS-STEPS TO SUCCESS

You can use workflows to automate data changes and
initiate Edge Cloud actions whenever something happens in
your Edge Cloud system. Depending on the type of

workflow, you may be &

prompted to complete an ]

action before you continue L Oy
| Bttt Yart <

with another task. That's
great, but what IF
workflows did a little bit of
thinking for you, too? What

orthodontist abbreviation, patient age years, patient status,
and treatment abbreviation. For this example, choose
Patient Age Years. The selected Table should now fill in
LR e automatically for you. Click
OK at the bottom to close
& Right Value |; this window, then click the
... by Conditions to go
right back in. Now fill out
the Selected Variable and

for most IF workflows, you

IF they figured out who the [ - Rt : need to choose @Patientld.
Warlahis Type o] 1l | | Varisbie Types | Int 1=
doctor was and moved the Pt Patbart Aagd Yoty =H | B F i At the top of the screen,
patient to the appropriate Fctd ol {Pateet - there is an Operator,
Leierind Variablie | GPabentd -

stack? What IF you could
figure out what office the
patient was in and move that patient to the correct TC's
stack. What IF the workflow ran one letter if the patient is an
adult and a different letter if they are a child? What IF? In
case you are not getting the hint here, you can run an IF
statement with workflows to even further automate them.
Cool, right?

If statement workflows are a step up from standard
workflows. If you are interested in learning more about
workflows in general, watch Edge Cloud Workflows: Five
Ways to Automate Your Practice video on
support.ortho2.com > Visual Help > 2021 Users Group
Meeting to become more familiar with them. Now, on to
creating if workflows.

In this example, we will use patient age and run a different
activity for an adult vs. a child. First, you need to start by
going to the Workflow editor. Click New to create a new
workflow and give it a Name that makes sense for how you
will use it. Once it's named, under the Common Activities
section, drag the If to the Workflow Activities section. This
will add an If and Else. Click on the If you just added and on
the right of the screen you will see Conditions. Click on the
... to the right of Conditions to go into the Conditions Editor

window.

In the new window, change the Field to what you are
looking for. Common uses are office abbreviation,

change it from equal to (=)
to less than (<). Last step,
fill in the Value in the Right Properties; type 18. Click OK.

Now that the if statement is created, drag the Merge Letter
Activity into the if statement.

-Workflow Activities
When dragging it in, place the 4 If Patient Age Years<18
merge letter on top of the if. If Merge Letter
4 Else

done properly, it will be indented
Merge Letter

below the word if. Do the same

step, but this time put the letter

on top of Else. This should also

be indented if done properly. Click on each merge letter to

choose the letter settings in Activity Properties on the right.

This workflow says if the Patient Age in Years is less than 18,

Workflows continued on page 14
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All of us have made mistakes; some big ones, some small
ones. Regardless of the nature or size of the mistake, it is
what you do after the mistake is made that will determine if
the mistake is a setback or a set up for a breakthrough!

More often than not, when we make a mistake, our first
reaction is embarrassment, followed by a cover-up/
correction with the hope that no one saw the mistake. If
someone has noticed
the mistake and asks
about it, the first
position he/she takes
is either denial or
justification. Neither
will produce the set
up for a breakthrough.
Rather, these responses close the window of opportunity for

positive change.

It is very understandable that many people feel
uncomfortable and defensive when facing their mistakes.

| dont know anyone who had a teacher who circled all
the right answers in red. We struggle to do things right
and when we don't, we imagine consequences that we
don’t want to become a reality. Most of the fears of the
consequences come from the past when our choices were
more limited and we had less power to effect positive
outcomes. For example, we've been conditioned (through
school, our parents, church, mentors) to think we are good
when we score high on tests, and bad when we don't.

But if we stay in the present, we can make conscious choices
of how we will interpret and deal with consequences. We
can choose to interpret mistakes as great moments for

learning!

Another great interpretation of mistakes comes from Randy
Pausch, author of The Last Lecture, who said when someone
rides you it means they care about you. When you do a poor
job and they don’t say anything, it's because they’ve given
up on you. Those of us who have ever been on a sports
team understand this dynamic; the coach spends the most

time with the “A”" players, the players who show the most

“On no account brood over your
wrongdoing. Rolling in the muck is
not the best way of getting clean.’

Aldous Huxley

promise, and the ones who are open to correction knowing

that the input will make them better players.

We really have little if any control on how others act in
response to our mistakes. However, we do have control

on how we interpret and react to them. In an ideal world,
everyone would take time to pleasantly interact with us,

be aware of our feelings, and speak to us in a kind and
positive manner. Since we
don't live in an ideal world,
the best option is to choose
the highest and most

’ empowering interpretation
of the correction: accept
the correction and reject
the tone and manner of the
input that doesn’t work for you. (Or as my mother used to
say, “Don’t throw the baby out with the bath water!”)

One way to take the sting out of corrective conversations

is to change your view of them. Instead of calling them
‘criticisms’ (which Oxford dictionary defines as the
expression of disapproval of someone or something based
on perceived faults or mistakes) call them ‘feedback.” We all
need feedback and we are all getting feedback daily without
any upsets attached! For example: modern cars send an
alarm if the driver comes too close to another object; our
inner ear mechanism keeps us in balance and lets us know if

Success continued on page 14
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MAKING ORAL HYGIENE A

PRIORITY

ONBOARDING YOUR STAFF
EFFECTIVELY TO SET THEM

UP FOR SUCCESS

Excellent communication and effective coaching with
our patients is more vital than ever before. For over a
year, people have had limited face-to-face contact due to
COVID-19, causing a change in behavior for many youth.

As practice teams continue to adapt to changing safety
guidelines, it is also an opportunity to rethink patient
education strategies. Many practices have embraced the
concept of virtual appointments for aligner and retention
checks, elastic wear, etc., to monitor treatment and provide
encouragement. No masks are needed, so patients can see

smiling faces!

Orthodontists continue to strive for treatment that require
fewer appointments and shorter treatment time. As we
minimize the number and frequency of appointments
needed to create stunning orthodontic results, we rely more

and more on patient compliance and parental support.

Client teams have shared with me that patient oral hygiene
has slipped for many patients during COVID-19 and they
are observing increased decalcification. In offices where
family was not allowed in the clinic, parents may not have

been aware of the change in their child’s oral health.

Procedure times typically do not have time allocated

for detailed oral hygiene instructions. Now is the time

to review clinical protocols and formulate a strategy to
advance patient education and motivation. Here are some
possibilities to consider:

1. Implement an attitude of oral hygiene excellence
throughout the office. Making oral hygiene a priority
sends a message to the team to focus on this important

topic with each patient.

2. Start patients only when they have a true grasp of how
to keep their teeth clean without appliances. As we
know, it is harder to keep the gingival areas clean with
brackets, so being a good brusher prior to treatment
makes education easier.

3. Use Edge Animations to make a customized office
video for patients and parents to view on your website

to refresh their memory. Make it engaging!

4. Analyze your procedure times. Is there enough time
to provide feedback at each appointment and provide

coaching as needed?

5. Include parents in oral hygiene instructions and
updates.

6. Encourage patients to evaluate their own oral hygiene
at each visit as they look into a mirror at the chair.

Institute a reward system for excellence.

7. Have a team member available who can step in to see
the next patient if detailed oral hygiene instructions are

needed.

8. Add a virtual appointment 2-4 weeks after bonding
(instead of the standard 8-12 weeks) to check and
discuss oral hygiene, food choices, and confirm all is
well with their appliances. Some practices do this on a

non-doctor day.

9. Implement the position of Oral Hygiene Specialist who
would coordinate effective education protocols and

coach on effective verbal skills for all team members.

10. Between appointments, send supportive reminder
blasts and/or text patients with a caring, encouraging

message.

Oral Hygiene continued on page 15
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In all our years in the dental industry, we've seen and

learned what works and what doesn’t when onboarding
new employees. Taking the time to do this properly not
only sets up your new staff for success but also ensures
the melding of protocols and expectations in the office.
Embrace your Practice has the steps to have the proper

systems in place for your new employee to succeed and not
fail!

To be able to effectively onboard your new hire, you should
be certain that they are the right fit for your practice

before they're hired. It is important that this person doesn’t
just perform a job, but enhances your practice’s overall
efficiency for you and your existing team. By simply putting
together the right job description that outlines exactly what
is lacking or needs improvement, you can narrow down
your applicant pool significantly in order to make a timelier

decision from a more niche group of people.

When hiring, be aware not to just fill a position but to bring
someone in that will bring a new set of skills, knowledge,
and a fresh perspective and energy. Look for a person

who won't just work at your practice, but has the ability to
change it for the better. From there you will already have
set yourself and your team up to work with someone who is
willing and able to learn, and who has the skills to raise the
practice up as a whole.

In our experience, companies that have a structured
onboarding process see a higher employee retention rate.
In fact, 94% of employees expressed they would stay at a
practice longer if the practice invested in their career more.
This sense of care should start from the very beginning; the
time and energy spent educating and integrating your new
employee will not only set them up for success, but also

instill confidence in their journey with your team.

This onboarding process should be systematic to ensure
repeatability across the board. First, you take care of what
you're required to do by law. After that, your onboarding
activities should focus on getting your new employee
settled and grounded, making sure they have the best
possible chance to learn, and assessing their capabilities

and fit for your team.

No matter the urgency, you will still want to put
considerable effort and time into every hire you make.

No matter how pressed you feel to fill a position, the fact
remains that we as employers still need to attract, identify,

and hire great people for our teams!

After all, how will the perfect hire find you if you don't take
some time to let them know that you need them? How
will you know if you're asking the right questions in the

interview if you don't already know what you're looking for?
To locate that perfect hire, identify and articulate:

1. The tasks the new hire will need to perform.

2. The qualities the new hire will need to have.

Sometimes, knowing what you don’t want is just as valuable
as knowing what you want. That's because knowing what
you don't want can help you figure out what you need.

Once you find the person to fit your unique office puzzle,
you will want to make sure their first week is spent utilizing
each day. Here is what we recommend:

Day one should be spent getting all employee paperwork
finalized along with having them get familiarized with the
office manual. Make sure to give them enough time to

read through it and allow for questions to be asked before

Onboarding continued on page 15
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CHAT, TEXT, TWEET, CALL, EMAIL, MESSENGER! OMG | GIVE UP!

In today'’s fast paced orthodontic practice, managing the
way patients and potential patients communicate with our
practices has become harder than ever before. Managing
multiple communication methods and communicating with
patients in a way in which they wish to connect is really
making practices rethink how they do business. Before you
give up and decide that all patients should conform to your
rules, let’s talk about the ways people communicate and
find technology and tools to help your practice become
the uber-friendly, patient-centric place that keeps patients

coming back and referring friends for years to come.

First let's discuss the ways patients connect now. In order
to really understand how patients want to communicate,
we have to know how they are connecting with our practice
now and look forward to how they may connect in the
future. Right now, in most practices, patients are directly
trying to make or reschedule appointments or discuss
treatment via online chat (on your website), text, phone,
email, website forms, and Google/Facebook/Instagram
messages. So right now in your office, your team has to try
to manage up to six communication platforms at once. This
is challenging for almost every practice, no matter the size.
The other important factor is the way in which your brand
vision is communicated in all of these channels. What you
say on the phone should be the same messaging as what
you text, chat, message, or email. Your brand must shine
through no matter where you connect with patients. The
fact is, good training and great technology can help you be

the best you can be.

The Most Important Communication

Tool is Still the Phone

Although many teens and 20-somethings believe that
texting is the best way to communicate, believe it or not,
the phone is still the top dog. If you do nothing else, make
sure you have an amazing communicator and people
person at the front who can connect with new and existing
patients and share your brand benefits like he/she was
born in the practice. In your office you probably have
phone scripts or branded messages that are used when

answering the phone. Many practices use some variation of

“Name Orthodontics... How can | make you smile today?”
which translates into, “We are happy to work here, we
love our practice, and we are excited that you are calling
us”. The deterioration of the call starts after the scripted
greeting. The messaging for calls changes depending
upon who answers the call and their training. The goal of
multi-channel communication is to put the absolute best
face on every communication method and that starts with
the number one method of communication, the phone.
Scripting is an important part of initial training of the team.
Once trained, additional fine tuning on the challenging
aspects of calls is crucial. Remember, many 20-somethings
literally never answered their home phone let alone any
phone that wasn't in their pocket. They have zero personal
knowledge of how to answer a business phone, so training

is key. It all starts with branded messaging on every call.

Creating scripts for all occasions is necessary to keep
everyone on the same path. When working with your
script, remember to have a script for all types of questions.
| recommend taking a few weeks to have your team write
down the questions they receive on a daily basis. This may
seem like a painful exercise, but its crucial to understanding
what you need to answer. Once the questions are written,
you can decide which are the most common and write
scripts for each. After the scripts are done, coach the team
on the way in which the questions should be answered. Use
the scripts you have created to play games and allow the

team to make the talking points their own.

Broadening Your Brand to Messages
and Mail

Once you have the script and the amazing team, next

you need to take that and connect it to all of your other
channels. This is where it becomes a little more challenging
but not insurmountable. Make sure that all of the messaging
that you want to give to patients is scripted and written

out for your team to follow. They should have cheat sheets
for everything you have developed. In your chat and text
platforms use your scripts to develop templated replies that
require your team to simply add a few personalized details

to quickly answer messages. Make sure that every one of

your text and chat messages matches the phone scripts or
other internal messaging you have created. Each email that
is sent should have some of the scripted messaging to allow
for fewer errors and a branded experience for every patient
who reads the email. Once you set each of these messages
up the way you want them you won’t have to worry about

them again for a few years.

Many practices do not spend their lives on social media
during the day, but patients do. The majority of patients are
glued to their phones and in a lot of cases check their social
media two to three times an hour. In many cases this leads
to patients chatting with your team via the method that the
patient finds most convenient — the messenger or Google
My Business (GMB) app. Unfortunately, in a busy orthodontic
office, it's hard to see when a messenger message pops up,
a chat appears, a text arrives, or a GMB message comes

in. The problem is people who use these platforms expect
an immediate response. When you don't respond within

a few seconds of their message they will, in many cases,
move on. This is especially true of new patients who are
scrolling through looking for a new orthodontist. They want
and expect a response and it's important that we respond
to them as soon as possible. Utilizing saved responses,
automated messages, or chat bots on messenger really do
help save your team time and energy and allow patients to
feel like you are responsive. Although no one likes to talk
to a chat bot, programming the bot with the questions you
most frequently are asked really does help.

Utilize your social channels to spread your brand message
without needing further patient interaction. Add highlights
to your Instagram page that include stories created by your
team that answer the most frequently asked questions. Add
TikTok videos in the same fashion that utilize your awesome
team members explaining how braces are placed, what to
do after getting braces, how retainers are made, and why it's
important to wear them as directed. Use as many channels
as you can to create a brand presence which not only
connects with patients in their preferred venue, but answers

questions in a branded, fun way.

Closing the Deal

The most important part of patient communication is closing
the deal with a new patient and that’s where technology
can really play a key role. Whether you use a chat or text
system, messenger or an email, reminding new patients
that they can make an appointment online is key. There is a
lot of pushback from doctors who do not want patients to
set their own appointments and | understand that train of
thought, but having the ability to choose an appointment
time and date sets your office above the others who aren’t
willing to do this. We book hotels and cars and flights
online, we bank online, surely we should allow our patients
to schedule online without the need for our team to control

the schedule.

Online scheduling for live appointments is just the first step.
Virtual appointments have changed the landscape of today’s
new patient experience. Utilizing the easy tools for virtual
appointments, your team can handle far more new patients
than in the past, and a TC can see patients in off hours
which are more patient friendly. This type of outside the
box thinking creates an environment in which the patients
are seen initially either by both the doctor and TC or in
many cases by the TC alone. Either way, the patient gets a
feel for the office and the type of treatments available and
can commit to an in-person records visit to get started with

treatment.

Communication Systems continued on page 15
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INSIDE ORTHO2

VISUAL HELP ROUNDUP

For many years, Ortho2 has offered free webinars for you to attend on various Edge Cloud and ViewPoint topics. With the
launch of the new Support.Ortho2.com, and the new cycle of Edge Cloud releases, it was a good time to transition away
from scheduled and pre-recorded webinars. Instead, we are focusing our efforts on updating existing and creating new

Visual Help videos as new features arrive in Edge Cloud.

This quarter highlights the Scheduler videos. The 14 videos in this section cover everything you need to know about setting
up and using your Scheduler. Some of the videos include:

* Navigating the Scheduler: Watch this video to see the basics of using your Edge Cloud Scheduler.

*  Smart Scheduler: Learn how to use the powerful tool that is the Smart Scheduler.

e Manually Scheduling an Appointment: Review how to make an appointment without using the Smart Scheduler.

e Editing an Appointment: Learn how to change or edit appointments that are already scheduled.

e Managing the Needs Appointment List: Explore the ins and outs of the Needs Appointment List and how to keep this

list in a manageable number.

If you have a topic you'd like to see covered in a Visual Help video, email ortho2support@ortho2.com.

Information about the people of Ortho2 and the resources available to you as a member

RETRAINING

Have you hired new team members since your original software training? Has someone on your team taken on new

responsibilities? Do you feel you might not be taking advantage of the enhancements that have been added over the years?

Ortho?2 offers many options for refreshing your knowledge of old features and informing you of new features, but do you
want to be able to set your own agenda to meet the specific needs of your practice?

A retraining — either in your office or over the Internet — addresses all these issues. To learn more and to schedule one for
your practice, contact your Ortho2 Regional Manager today at sales@ortho2.com or 800.678.4644.

CHAT SUPPORT

Do you need to call into our Support Team for a question, but it's difficult to wait on hold, even for a few minutes? Ortho2
has you covered! Use our chat support to get in contact with us. When you use the chat support feature, you will be added
to the same queue as phone calls. You can choose to chat with the Software Support, New Customer Care, or Network
Engineering Teams.

In Edge Cloud, you can find links to chat support through the Help menu. In ViewPoint, click the Help button in the bottom
right of the Daily Activities menu.

CONTACT US

Phone Email Social Media
800.678.4644 (Sales) accounting@ortho2.com facebook.com/ortho2
800.346.4504 (Support) admin@ortho2.com youtube.com/ortho2systems
. engineering@ortho2.com twitter.com/ortho2systems
Website . . .
ideas@ortho2.com linkedin.com/company/ortho2
www.ortho2.com .
orders@ortho2.com instagram.com/ortho2systems
L. ortho2support@ortho2.com blog.ortho2.com
Newsletter Submissions .
sales@ortho2.com ortho2.uservoice.com

ditor@ortho2.
editor@orthoZ.com ugm@ortho2.com

HELP US HELP YOU

Please be prepared to provide your customer number, practice name, and office location when you call our support teams
for assistance. You can find your customer number in Edge Cloud by clicking File > About. If you use ViewPoint, you will
find your customer number by clicking the Help menu and choosing About. Please be sure to provide this information—and
repeat your phone number—when leaving a phone message requesting support. Having clear information helps us serve

you more quickly.

HOLIDAYS

Our corporate office is closed on the following holidays:

New Year’s Day Independence Day Thanksgiving Day
Memorial Day Labor Day Christmas Day

If a holiday falls on a Saturday, we observe the holiday on the prior Friday. If a holiday falls on a Sunday, we observe the
holiday on the following Monday.

The Friday after Thanksgiving, Christmas Eve, and New Year's Eve are optional holidays. We offer limited support on those
days.



INSIDE ORTHO2

Information about the people of Ortho2 and the resources available to you as a member

MEET THE TEAM - INTERNAL SERVICES

The Ortho2 Internal Services Team does more than just facilitate our internal projects and our customer database. They also

coordinate and complete conversions and custom projects for our customers. This quarter, we are featuring Ken Hoffmeier,

Internal Services Programmer and Elizabeth Nordeen, Internal Services Projects Coordinator.

What do you really do here at Ortho2?

KH: | do the ViewPoint to Edge Cloud conversions and

administer Ortho2's customer database.

EN: | coordinate the custom projects, whether it is a custom
report, online forms, or custom programming.

What's fun/what do you enjoy about your current job?

KH: | like the autonomous environment that Ortho2 provides

Ken Hoffmeier

Vacation destination: Australia Zoo
Three people | would like to have
dinner with: My oldest brother who
passed when | was nine and | never
really had a chance to know him,
Steve Irwin, and Stephen Hawking
My role model: Stephen Hawking. |

find it unbelievable what he managed
to accomplish in his life while battling ALS.

| can’t go a day without: A book

What are you listening to right now? Dire Straits

Favorites

Team: The Lakers

Software Program: OneNote
Movie: Quigley Down Under
Book: To Kill a Mockingbird
Phone App: Libby Overdrive

EN: There is a little something different every day.

What do you want our users to know about the Internal
Services Team?

EN: We are a small team working to get a lot done.

Elizabeth Nordeen

Vacation destination: | have two:
One would be to spend time at a
really nice cabin that had a deck
over water that | could fish off of.
The other would be to spend time
at one of those beautiful huts that
are built over gorgeous crystal blue

waters.

Three people | would like to have dinner with: My grandpa
and my grandma. | wouldn't need a third if | had them at the
table.

My role model: My brother, Steve

I can't go a day without: Laughing and spending time with
my kids

What are you listening to right now? Going between the
Smartless Podcast and the Avett Brothers

Favorites

Team: lowa State Cyclones

Snack: Lays potato chips and AE Mexican dip

Movie: Anything when movie theater popcorn is involved
Podcast: Smartless

Phone App: Instagram

ON A PERSONAL NOTE

Congratulations to Sara Harbacheck on the birth of her grandson, Graham Jack Goodman! Sara,
Ortho2 Help System Developer, reports that Graham was born on July 31, 2021 while family and
friends were enjoying his baby shower. Surprise! Although he was four and a half weeks early, he's
home and healthy and growing every day.

ORTHO2 ANNIVERSARIES

Congratulations to these Ortho2 staff members who celebrated anniversaries during the third quarter of 2021.

Thirty-Four Years Ten Years Seven Years
Sara Harbacheck Brent Jacobsen Nathan Hemmings
Steve Mahan Jorge Rios
Sixteen Years
Michelle Kinnaman Nine Years Three Years

Rachel Gildersleeve Darcy Dakovich

Thirteen Years

Cal Rebhuhn Eight Years One Year

Wesley DeShaw Jeff Brockway

Twelve Years Marley McDonald

Judy Denny

SERVICE EXCELLENCE

We invite you to recognize Ortho2 employees by submitting an Extra Mile form. The form is available online from the
Contact Us page of our website. Our goal is to uphold our tradition of excellence in customer service, and with our Extra
Mile program, you can let our employees know when you appreciate their extra effort. We encourage you to submit an
Extra Mile form whenever an Ortho2 employee goes the extra mile for you. The recognition is valued by the recipient and
is acknowledged by our management team. We continue to look for better ways to serve you. Thank you for helping us
recognize excellence.



President’s Perspective continued from page 1

Meeting pivoted to an online meeting earlier this year

with great success. Ortho2 is exploring the possibility of
continuing a virtual meeting, either in role-focused boot
camps offered throughout the year, or alternating every
other year between in person and virtual users meeting. We
hop you join us for the 38th Ortho2 Users Group Meeting,
January 27-29, 2022 in Las Vegas.

Henry Schein Collaboration — Ortho2 and Henry Schein

continue to explore avenues we can work together to bring

more valuable offerings to both the Ortho2 and Henry
Schein family of customers. Some offerings are already
in place, for example a deeper integration and website
offerings through Sesame. Other avenues of particular

interest are enhanced insurance billing and analytics.

This is just a quick overview, but please know everyone at
Ortho2 is working hard for you. After all, our mission is to

Amy Schmidt

Amy Schmidt, Ortho2 President

help you succeed. 0

Workflows continued from page 4
run this merge letter, otherwise (Else), run this letter.

In the end, workflows are a powerful way to automate

the system to streamline some of your office’s tasks or

procedures. If Statement Workflows take that a step further
by providing a little logic into the automation. o

Success continued from page 5

we lean too far over; our sensory system lets us know when
we touch something hot, or when things are cold; our taste
buds let us know what foods we like; our pets roll-over to
get their tummies rubbed; etc. There are thousands of ways
we get feedback on a daily basis without getting upset. But
if every one of these situations I've described were called
criticisms your reaction would be different! Wayne Dyer said
it best, “When you change the way you look at things, the
things you look at change.”

Ultimately, if we're growing and learning, we WILL make

mistakes; and if we can’t handle correction, then we won’t

grow. Whether or not you have a great coach or teacher,
you need to learn to be your own best coach. If you've had
children, or ever watched a child learn to walk, you know
that after a few steps, the toddler falls down. The adults
start clapping their hands, encouraging the child and being
a cheerleader for the child. If the adults started to berate
the toddler for going past the center of balance, and
punishing him or her for falling, the child would develop a
fear of walking! As adults, start encouraging and being a
cheerleader for yourself and others as we all are taking baby

steps in learning to walk on the path of life’s journey! o

Oral Hygiene continued from page 6

11. Confirm all clinicians are grading oral hygiene the same
way. Make a sample grading with photographs to help
new team members accurately document decalcification

as soon as it is seen. Be specific on location.

12. Clarify when letters are sent to parents. Do you send a
letter at the first less than ideal? The second time? With
longer intervals between appointments, the second
poor OH grade could be too long before parents are
notified. Be consistent so all patients receive the same

quality treatment.

13. Review letters to confirm that the message you wish to

convey is clear.

14. Utilize Pro Seal, L.E.D Pro Seal or other protective

sealant to mitigate decalcification.

15. Utilize Ortho2 to the fullest at the chair with workflows,

animations, and more!

These are few ideas to stimulate your thinking. Find what
works for you! As with any goal, clarify objectives, make a
realistic plan, execute the steps, and evaluate progress. Then
celebrate the difference you make in your patients’ lives! o

Onboarding continued from page 7

signing off that it has been read. Day one should also be
spent going over the defined outline of their role and what

their position entails.

Days two and three are meant to give your new hire a
chance to get to know each department by shadowing each
department lead. On day four, your new hire will watch
videos on the practice management system and all programs
that are used in the practice. Finally, on day five a team
member from the department your new employee was hired
for will get a checklist following the explain, see, do system
for the following week’s training. Each week should end

with an evaluation that they have mastered each job duty; it

should be noted that the new employee cannot move onto

the next job duty until they have mastered the one before it.

Lastly, give your employee the confidence to learn in a
setting that will not put them in a position to reflect poorly
on the office. You want to see them succeed! Do not let
them feel discouraged by throwing them into situations they
may not be ready for.

Hopefully, with your thorough and direct method of
employee search, hire, and onboarding you will have set
yourself, your team, and your practice up for success. After

all, when one succeeds, we all succeed! o

Communiations Systems continued from page 9

OmniChannel Practice Integration is
Coming

In the near future, we will see a few companies providing
omnichannel products that allow you to respond to all

of your messages, email, texts, forms, and more in one
place. There are a few software companies who have some
of the pieces already, so in the not so distant future you
will be able to manage all of your tasks under one roof.

In the meantime, make sure that you have the scripts you

need to be able to handle 90% of the calls, texts, emails,

messages, and other communications that you receive. Set
up chat bots to handle the common questions you have
discovered with your team so that the answers to most of
the mundane things are available to all of your patients and
potential patients whether they are on your GMB, Facebook,
Instagram, TikTok, or website. Branding your practice with
the most up-to-date, informative messaging which helps
patients commit to treatment and solve treatment questions

will set your practice apart from every practice in town. o
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